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 Up to this stage of the MIS development we could determine 

database structure (or data model) by determining data tables and 

their 3NF relationships and data media required for transferring 

data within the system and from/ to the database

 In detail design of an MIS system we need to develop data media 

recognized for the model

 Detail design and implementation has two stages: 

1) Collecting set of data required on the data flow media from 

different data tables: It is the subject of Queries! 

2) Presenting data collected on data flow media: It is our subject 

in forms development
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Example:

Remember data flow in 

our Bid Management 

System.

Lets focus on bid 

information!
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Example: Bid form from database is our main tool for bid data flow: 
Data flow Media 

Sending subscription information 
Email; Using provider’s online form; Using provider’s tel-lines; filling in 
client’s form and sending by mail 

Receiving new projects info (from data 
providers) 

By Email; Letter; Directly reading from online account 

Using historical bid results A database-form (historical result form) 

Sending new projects’ info 
 

A database-form (announce project form) 

Storing new projects’ info A database-form (announce project form) 

Storing project analysis result 
Copy of documents on the contracting manager’s computer/ shelf; 
Info record on a database-form (announced project form) 

Storing submitted bid docs info 
Original documents of documents on the contracting manager’s 
computer/ shelf; Info record on a database form (bid form) 

Requesting new bid info (from client) Verbally; phone; through email 

Receiving new projects info (from client) Verbally; phone; through email; letter 

Submitting bid documents Envelope; client’s online website 

Requesting bid results Verbally; phone; through email 

Receiving bid results Verbally; phone; through email; letter 

Storing bid results  Info record on a database form (bid form) 
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Example:

What information do we need to present on bid form?

 Project size

 Project type

 Bid decision reason

 Client name

 Client Tel

 Client contact person

 Submission date

 Value

 Result

 …
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Example:

1) Query helps us to find and collect related data from different 

data tables (New project, Client and Bid) of database

2) Bid form uses provided information by query to present data 

required on bid form

More information on each of these MIS development tools is 

discussed in the rest of the lecture! 
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Queries
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 In general, a query is a form of questioning, in a line of inquiry, and 

is used for communication with database!

 By using queries, selective set of data from/to different data tables 

can be selected/ inserted!

 In databases, queries are usually commands that we use for 

communicating with the database engine. They can be sent to the 

database engine directly through command line (if provided by the 

database; MS Access does not have a command line), through 

interface programming codes  or by using set of tools provided by 

database software packages!



Introduction to queries

11

 Special language called Structured Query Language (SQL) has 

been developed for creating queried through scripts to the 

databases engine. 

 To make the process of query development simpler, Microsoft has 

developed a special visual environment for query development for 

MS Access developers. 

 Before start developing queries refer to data flow medial analysis 

results to determine data titles and data rows required for every 

media which has been identified.
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 Hands on software (MS Access):

 Create query - design 

mode
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 Select queries are meant to retrieve required data tables stored in the 

database. 

 Hands on software (MS Access):

 Showing all records all fields

 Presenting selected fields

 Conditions on selected fields

 Calculated columns

 Aggregation queries

 Queries on several tables

 Queries on queries

 Column properties

 SQL   (Quick guide, Detail guide)

https://www.tutorialspoint.com/sql/pdf/sql-quick-guide.pdf
https://www.stat.berkeley.edu/~spector/sql.pdf
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 Append (insert) queries are meant to add new data-rows to the required 

data tables within the database. 

 Hands on software (MS Access):

 Direct data entry

 Append data by query

 Append from other tables

 Properties

 SQL
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 Delete queries are meant to delete data-rows from to the required data 

tables within the database. 

 Hands on software (MS Access):

 Creating a  delete query

 SQL
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 Update queries are meant to update data items within currently stored 

data-rows in the database. 

 Hands on software (MS Access):

 Creating an update query

 SQL
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 Update queries are meant to update data items within currently stored 

data-rows in the database. 

 Hands on software (MS Access):

 Creating a query

 SQL
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 1) Use our bid management system 

data model to create MS Access 

database. 

 Note: No space should be used in field 

(or attribute) and Table (or entity) 

names in the database!

2) Create database relationship 

3) Use data in the MS-Excel file to 

directly fill data in data tables 

4) Create a query presents all project 

bids we have bided on in 2013

5) Create a query which shows 

different types of projects and 

contracts we have not won!

Announced Project

*APId

-Client Id

-Date Announced

-Due Date

-Project Type Id

-Contract Type Id

-Prj Description

-Prj Location

-Prelim ManH

-Prelim Cost

-Bid Bond Value

-Decision on Bid

-Decision Reason

Bid

*Bid Id

-APId

-Date Submitted

-Bid Value 

-Result Date

-Winner Id

-Winner Value

Project Type

*-Project Type Id

-Title

-Description

Contract Type

*-Contract Type Id

-Title

-Description

Client

*Client Id

-Client Name

-Private-Public

-Office Location

-Contact Num

-Fax

-Email 

Competitor

*Competitor Id

-Competitor Name

-Office Location

-Contact Num

-Fax

-Email 

Bid-Competitor

*Bid Id

*Competitor Id

IT-L06-AfterClass1_bidSys_data.xlsx


After class practice 1

19

6) Create a query which changes all Cost plus projects to Unit price 

projects!

7) Create a query  to insert a new project to the announced project table. 

The new project is very similar to “Sadr Highway” project, the only 

change is that it is going to be for “Hemmat Hightway” and the date is 3 

months later

8) Create a query  which shows the total value of all projects we have won!

9) Create a query which deletes “Tehran” from our competitors!

10) Create a new table the same as “Contract type” called “Subcontract 

type”

Compress your file (in a zip format) and send it to the TA
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 SQL is a special language developed for communicating with database 

engine.

 All query features discussed and in last slides can be implemented directly 

by using SQL code.

 As a matter of fact, MS Access it self translates all those visual 

implementation of the queries to SQL codes and then communicates with 

database engine!



Introduction to Structured Query 

Language (SQL)
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 Because of time constraint in the course and because MS Access can 

support all we are skipping required SQL codes in a visual manner we 

avoid entering SQL programming.

 If you were required SQL code for any types of queries you can easily 

develop it through MS Access query development tool and use the code

 You are absolutely encouraged navigating SQL codes of different queries 

developed by using MS Access query development tool.
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Data Forms 
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 Forms provide a more controlled and directed access to the data in a database 

application for the database users (remember how difficult and error-prone direct 

data input is!!!!)

 In most management information systems the main (or even usually the only) 

interface that users are dealing with are forms!

 Example 1: 
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 In information systems, forms are the main interactive media (or tools) which 

involves system users in creating, updating, transferring and removing data in 

computer databases!

 What other ways do you know that might be used for manipulating data in 

database? 
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 Query and form can independently write/ call data into/ from database; however, we are 

forced to use queries if we want our forms’ data go into/ come from several data tables.

 Use of queries for retrieving data from or updating databases is almost always limited to the 

information system administrator or through stored procedures within the databases.

 If we want to communicate with database interactively and via users,  forms are our best tool 

for doing it.

Form Vs Query:
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 How can we figure out what kinds of forms do we need in our system? Among 

different system analyzing tools which tool is more appropriate?

Using results achieved in our data flow media analysis

Example: Remember data flow media analysis we developed for out bidding 

management system

Data flow Media 

Sending subscription information 
Email; Using provider’s online form; Using provider’s tel-lines; filling in 
client’s form and sending by mail 

Receiving new projects info (from data 
providers) 

By Email; Letter; Directly reading from online account 

Using historical bid results A database-form (historical result form) 

Sending new projects’ info 
 

A database-form (announce project form) 

Storing new projects’ info A database-form (announce project form) 

Storing project analysis result 
Copy of documents on the contracting manager’s computer/ shelf; 
Info record on a database-form (announced project form) 

Storing submitted bid docs info 
Original documents of documents on the contracting manager’s 
computer/ shelf; Info record on a database form (bid form) 

Requesting new bid info (from client) Verbally; phone; through email 

Receiving new projects info (from client) Verbally; phone; through email; letter 

Submitting bid documents Envelope; client’s online website 

Requesting bid results Verbally; phone; through email 

Receiving bid results Verbally; phone; through email; letter 

Storing bid results  Info record on a database form (bid form) 
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 How can we figure out what kinds of information should go on a form ?

 Depending on the application of a form and data flow in the system some or all 

of fields (attributes) created for data tables (entities) are used in forms!

 So, for properly creating a form we need to review the form’s mission by looking 

at the related data flows (in dfd) and data tables involved (3NF ERD or data 

model)!

 At the rest of this lecture we discuss different features of form development in 

MS. Access!



Creating forms
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 By selection the form and then selecting: Design> Property 

Sheet, Form Property Sheet will appear/ disappear 

(consecutively). Form properties are divided into four main 

parts: 1) Format (for adjusting form appearance) 2) Data (for 

setting up form’s link to the database) 3) Event (for handling 

actions required on specific events happened!) 4) Other (for 

adjusting other features which are out of mentioned 

categories) (All, as the last category, includes all properties!)

 There are many properties available for the form. In this 

lecture we just discuss some of most applicable properties. 

 Note: Most properties configure the form specifications on 

the Form View !
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 Record Source: Determines record set to be linked to the form as explained in the Form 

fields slides. You either select record set from drop-down list of tables and queries or 

directly develop a customized query (same as query design area).

 Allow Additions: Determines whether the a new record can be added on the Form View 

(Yes) or not (No). 

 Allow Deletions: Determines whether the a whole record can be deleted on the Form 

View (Yes) or not (No). 

 Allow Edits: Determines whether record fields can be edited on the Form View (Yes) or not 

(No). 

Show drop-

down list of 

tables and 

queries

Open customized 

query 

development area Customized 

query 

development 

area



Form fields

31

 Forms can be created (recommended method) by following: Create>Form Design

 To be able to be linked to the database (data tables and queries) we need to link our 

form to a data-table or query by selecting the form, and following: Design> Property 

Sheet> Data> Record Source

Make

sure the 

form is 

selected!

Select the Property Sheet on 

Design tab

Select your desired table or query 

from the list of Record Source!
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 Field list becomes accessible by selecting: Design> Add Existing Fields. You can then 

adjust field locations, sizes and the distance between label and field by selecting and 

dragging the label and the field borders!

Select the Add Existing Sheet on 

Design tab

Select your desired fields by double clicking 

on them or dragging them on  the form

Adjust the field and label size. Note different 

shapes of the cursor when approaching the 

boarders when they are selected!

These squares 

are used for 

adjusting 

distance 

between label

and filed!

 Select: Design>View> Form View to see field values. As default, the first  record of the 

record resource you have selected will be shown. Push the record selectors at the 

bottom to change the record/ go to the new record mode.

new

last

nextprevious

first
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 There are different controls (Design> Controls) to be placed on forms. Some of them are 

meant to be linked (bound) to a field and present database data in their own way of data 

presentation and some others are used for the presentation and explanation purposes 

(are unbound)! By moving the cursor on the top of each control, a tool tip will be 

presented showing the control name. By clicking (or double-clicking) on a control, the 

control is selected and you can then draw the control on the specific location on the form 

that you like to use the control. You can also easily copy and paste the controls on form 

and populate them !

 By drawing some of to be bounded controls 

on the form, a control wizard gets open 

helping the user on customizing and 

bounding the control to the database. You can 

either follow up the wizard steps or cancel the 

wizard and set the control manually!

A Combo Box Wizard automatically 

gets open by drawing it on the form!
A label and a line control 

on the form (unbound)
Set of form controls provided by MS Access
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 Labels and text boxes are among the most applicable controls. By default when you 

select a field (previous subject), the supporting control is a text box, which is linked 

(bound) to the field, and a label as a caption which is unbounded but by default gets the 

name of the linked field. By default by choosing a text box a supporting label is also 

attached to it. You can select and delete the label in cases you do not need it on the form.

A bound text box, drawn on the form as 

a form field

An  unbound text box, drawn on the form 

as directly from control!

 More explanation on how we can bound and customize controls will be given later on in 

the lecture!
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 Hands on software (MS Access):

 Create a form linked with a table (tbleAnnouncedProject)

 Adding fields to the form

 Removing extra information

 Adjusting field names

 Create queries for the forms

 Working with controls (Combo boxes, Labels, Textbox, ..)
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 A form is divided into three parts: 1) detail (where usually fields are presented and by 

default is visible); 2) Form header/footer (presents data at the top of the form in the form 

view - Design> View> Form View); 3) Page header/ footer (presents data at the top of the 

page in the print view- File >Print). By right-clicking on the detail-ribbon on the top of the 

form (when no header/footer is chosen) or by right-clicking on the header/footer ribbons, a 

pop-up form drops down in which you can select/ unselect form/page header/footer.

A form with all 

headers/footers selected

(in design view)

Right-click on the detail 

ribbon to see the pop-up 

menu

Form header/footer stays 

at the top/ bottom on the 

Form View.

Page header/footer are 

not shown

On the print, form header comes at 

the beginning, form footer goes at the 

end of data presented on the detail 

part. Page  header goes on the top of 

each page and page footer goes on 

the bottom of each page
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 Caption: Sets the title of the form to be shown on the Form View!

 Default view: Determines the default presentation view of the form when it is opened!

There are 6 possible 

default view options

By default

“Single Form” is 

the default view

“Continuous 

Forms” “Datasheet” “Split Form”



Form layout view

38

 All view types of the form have been discussed in different parts of the lecture except 

Layout View! Layout View is used for adjusting the form’s layout when it is presented at the 

Form View. It looks like the Form View, but gives the capability to do layout and size 

adjustment on the form controls (easier than the Design View)!

In Layout View the form 

looks like the Form View but 

you can adjust its layout
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 Record Selectors: Determines whether record selector be 

shown (Yes) on the Form View or not (No).  

 Navigation Buttons: Determines whether navigation buttons be 

shown (Yes) on the Form View or not (No).

Record selector: Yes Record selector: No

Navigation Buttons: Yes Navigation Buttons: No



Form properties - format
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 Scroll Bars: Determines whether scroll bars be shown on the Form 

View when some controls are outside of the form limits or not!

 Close Button: Determines whether form’s close button be active at 

the Form View or not!

 Orientation: Determines the text orientation on the form controls 

from right-to-left or left-to-right!

Scroll Bars

Close Button



Form basic formatting 
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 Hands on software (MS Access):

 Form environment (header/footer)

 Form view

 Layout view

 Record navigation
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 Format: It is basically applicable for numerical values. The value 

types are very close to ones we had for MS Excel.

 Decimal Places: It determines the decimal place of the numerical 

values!

 Visible: It determines whether text box should be visible (Yes) on 

the Form View or not (No)!

 Back Style: To select Normal back style or Transparent!

 Back Color: Gives option to select the back color from the list or 

to pick a color from the color picker.

 Border Style: Different border styles can be picked from the drop-

down list (try different styles so that you can see the changes!).
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 Font Name: Selecting the font name.

 Font Size: Determining the font size.

 Text Align: Determining the text alignment.

 Is Hyperlink: Set it as Yes if you have a url (web) address 

on the text box shown and you want the user to be able to 

go to that address when is required!

 Fore Color: Gives option to select the font color from the list 

or to pick a color from the color picker.

 Keyboard Language: Determines the default keyboard 

language of the text box.
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 Control Source: Determines the name of the filed whose 

values are presented on the Form View in the text box!

 Default Value: Determines the default value of the text box  

where there is no other value is set for the text box!

 Enabled: If is set No shows the value of the text box in a 

shadowed format with no access for editing the value!

 Locked: If is set Yes shows the value of the text box in a 

regular format but with no access for editing the value!

Disabled 

(Enable: No) 

textbox
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 Name: Determines the name of text box. This name is usually 

used for referencing the text box on the programming mode!

 Control Tip Text: To determine the explanatory text which is 

shown when cursor stays on the text box for a bit!

 Tab Index: Tab index determines the order of filling the 

information on the form. It is called tab index since this 

order can be followed by consecutively pushing the Tab 

key! You can directly change the tab number to the 

order you desire or open the Tab Order by pushing the  

picker (...)

 Tab Stop: Determines whether the text box to be on 

the tab index list (Yes) or not (No). If text box is no on 

the tab index list, you will not reach it by pushing Tab 

key (just by using the cursor you can go to the text 

box).

Order of the rows 

represent the Tab 

Order. You can 

change the order of 

the by selecting the 

row and dragging it 

to the order desired!

Tab order 

can be set 

for the 

form 

Detail, 

header 

and footer

=0 (Tab index starts with 0!)

=1
=2
...
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 Note 1: Most properties discussed for the text box have the same effects on the combo 

box. Here we only discuss some important properties for combo box which we did not 

discuss for the text box! 

 Note 2: You can properly configure combo box by step by step following Combo Box 

Wizard which automatically appears after drawing the combo box on the form. In this 

section we discuss how you manually (by directly using properties) can configure a combo 

box! You will get a better understanding on the Wizard steps by understanding following 

properties as well. So, for now cancel the Wizard and start configuring the combo box 

manually!
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 Column Count: Determines maximum number of column to be 

shown on the combo box list!

 Column Width: Determines width of each column (separated by 

“;”) on the drop down list.

 Column Heads: Determines whether the column headings be 

shown on the list or not!

 List Rows: Determines maximum number of rows to be shown on 

the combo box list!

 List Width: Determines the width of the combo box to be shown!

Column 2 Heading

Combo box with 2 columns and 3 rows

Combo box value



Combo box properties - data

48

 Control Source: Determines the field name in which combo box 

value will be stored. Can be selected from the dropped down list.

 Row Source: Defines the record set is used for filling information 

on the combo box list! It can be selected from drop down list of 

queries and tables or by directly defining a query. Query 

development environmebnt will be opened when “...” button in 

pushed!

 Bound Column: Determines the row source (= shown on the 

combo box list) column number whose data needs to be stored in 

the control source. For example: We have determined bound 

column number 2 which is CTID (or Contract Type Id) to be stored 

in the CotractTypeId field of the form!

 Limit to List: Determines whether all data stored in the control 

sources need be on the combo box list (Yes) or not (No)!

Bound Column = 2
Value of column 1 is shown but 

column 2 is bounded  and 

copied to the control source
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 Button is a control used for running different commands related to the form or to the 

database. By drawing a button control on a form the Command Button Wizard gets open 

for helping the form developer on different types of commands which might be required. 

The wizard automatically generates supporting VBA programming codes and suggests 

different button samples for different types of commands.

 There are a variety of VBA functions and form features for supporting button commands 

which is difficult to remember specially for the occasional form developers. It is 

recommended that you start developing form buttons with Wizard and then continue 

customizing and completing them using properties. 

 Navigate and see different Categories and 

Actions and see different categories and 

actions available for supporting button.

 For example we want to create a Close 

button by pushing which the form is closed!  

Categories: Form Operation> Actions: 

Close Form



Button properties - wizard 
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Close button created 

by use of wizard
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 Picture Capture Arrangement: Determines whether only 

Picture, or a combination between picture and the button 

caption be shown on the button.

 Picture: Can be added by pushing “...” button and 

working with the picture builder form.



Button properties - event

52

 Event is an action or occurrence detected by the program which may be handled by the 

program.

 Buttons are usually used to let the user apply his/her actions by creating on-Click event 

(i.e., by pushing the button). 

 A variety of events are defined for almost all controls. However, as a result of very their 

specific and advanced applications, we avoid explaining them.

 In this course we just discuss button’s on-Click event handling. You are encouraged to 

explore other types of events.

 On Click: Defines the handling method when button’s on-Click event is created!

By pushing “...” key, 

information of saved 

macro is shown 
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 On Click (cont’d): 

Let’s see how we can develop the Close button without using the Wizard. First select and 

delete “Embedded Macro” next to the On Click event. Then push “...” key to see your On 

Click event handling options.

By pushing “...” key, 

event handling 

options are shown 

Push OK  when 

Macro Builder 

option is selected

Select close from 

Action column 

drop down list!
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 On Click (cont’d): 

Use of Code Builder instead of Macro;

Push OK  

when Code 

Builder option 

is selected

Embedded Microsoft Visual Basic is opened!

Start writing your code here!
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 On Click (cont’d): 

The supporting code for closing the form is: DoCmd.Close



Button properties - event
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 On Click (cont’d): 

For using buttons for opening other forms (for building up a menu), in the Code Builder 

environment use code: DoCmd.OpenForm ("frmMain")

Select On-Click event for every 
button> go to Code Builder
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 Select:         > Access Options> Current Database> Display Form



Security warning
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 Select:         > Access Options> Trust Center> Trust Center Settings> Macro Settings> 

Enable all macros

 When you did the new setting, on 

your next file opening security 

warning will not apear!



Form control formatting
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 Hands on software (MS Access):

 Text box

 Combo box

 Button

 Default form

 Security warning
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 Bid form is a form for entering our bid information. Create a bid form which can 

be used for reviewing our past bids and can be used for creating new bids that 

we are going to participate. 

Where ever is appropriate use combo-boxes, buttons and other controls.

(Due: one day)
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 A sub-form is a form that is inserted in another form. The primary form is called the main 

form, and the form that is enclosed in form is called the sub-form. 

 A form/sub-form combination is sometimes referred to as a hierarchical form, a 

master/detail form, or a parent/child form.

 Sub-form and main form are linked to each other through (a set of) shared fields. 

 Example: In our 

bidding system we 

want a form which 

has the client 

information on the 

top and the list of (or 

history of) previous 

projects announced  

on the bottom. (the 

form is called project 

history).
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 Example (cont’d): In this example form frmClient has an embedded form frmClientProject. 

It is shown in the Design View of the form in below:

Form frmClient

as the main form

Form frmClientProject

as the sub-form
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 Example (cont’d): The linked field between two forms is ClientId! 

 Creating a sub-form:

Sub-form is among the form controls which can be selected  and 

drawn on the form! By drawing a sub-form on the form the Sub-

Form is started to help you setting up the sub-form. You can build your sub-form up on the 

currently developed forms, tables or queries! So before start drawing your sub-form control 

you need to have your desired 

database object prepared!



Sub-form
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 Creating a sub-form (cont’d):

At the Design View of the sub-form you have 3 levels of control selection: 1) Sub-form 

frame selection 2) Sub-form Form selection 3) Sub-form Form controls selection. After 

selecting a control you can adjust its properties correspondingly! 

Sub-form frame selection Sub-form form selection Sub-form form controls selection

Note : Sub-form properties also can be directly be adjusted by directly opening the sub-

form in its Design view. However it should be noted that at the time the form can be 

opened in one way (i.e., either opened in the main/ child form or as a separate and stand 

alone form)
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 Creating a sub-form (cont’d):

Source Object: If you need to change the sub-form object 

(e.g., from a form to another form), you can change the 

reference to the sub-form object by selecting the sub-form 

frame at: Properties> Data> Source Object

Link Master/ Child Fields: It is possible to change the link 

fields by changing Link Master/ Child Fields at: Properties> 

Data> Link Master Fields and Properties> Data> Link Child 

Fields . In cases that master form and sub (or child) form are 

linked through several fields use “;” for separating field names 

from each other.
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 Hands on software (MS Access):

 Sub-form creation
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 Sub-forms are used for  interactive data filtering in MS Access!

Select different dates and related records are interactively shown in the sub-form after OK button is pushed!
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 It is done by using sub-form and a small portion of programming! The design view of the 

form is shown in below. The significant change from form view to design vies is two 

additional unbound text boxed which have “Visible: No” properties and are used as

supports to the visible 

invisible at the text 

boxes. Another 

considerable issue is 

that the main form and 

all its controls are 

unbound since they are 

just used for filtering 

purpose and their 

values are selected by 

user.
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 The main basis of filtering is that we set a query for the sub-form object whose values 

are linked to the main-form filtering objects (i.e., From and To dates).

Date Criteria is linked to the main form text controls (txtFrom and txtTo) 

Query set for the sub-form object!
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 We need to set the filtering Criteria correctly:

 On the query side we need to set the criteria to show the dates greater than From

and the dates less than To.

 On the form control side, if user selects both ranges properly, the criteria logic 

works fine.

 The issue comes up when user has not selected a value(s) for one or both filtering 

text boxes. The logic says if there is no value it means there is no constraint, i.e., 

no value on From means all lower limit dates should be shown and no value on To

means all upper limit values should be shown. However, no value will send a Null to 

our sub-form query and will result in showing no result!!!

 We used our auxiliary and invisible text boxes to solve the issue. As a matter of fact 

these text boxes are linked to the sub-form query and we will adjust their values 

using Event properties and supporting VBA coding based on updates on the visible 

filtering text boxes.
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 In our logic we wanted to show there is no constraint if there is no value shown, it is 

translated in coding to set a far-past date for From filter and set a far-future date for the To 

if there is no date value selected by user. For example it is done for the from filter as:

Set default value of Invisible

From filter (txtFrom) as a far-

past date

Select “After Update” event 

of the Visible From Filter 

(txtFrom2) 

Set the condition in a way that if 

user’s From value in the Visible

filter txtFrom2 is not within the 

range (including Null values) 

automatically a far-past value is 

set for the Invisible filter txtFrom

which is linked to the sub-form 

query.

Push “...” button to go to the 

programming environment!

 Similar approach will be followed for To filters!
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 Your filter is almost done, but is not working until you do you last setting. 

 The issue is, although every part of program is logically right, we need to refresh the link 

between our filters and the sub-form query. 

 This last step can be done (there are also other ways) by using a command button:

Draw a 

command 

button. Cancel 

the wizard 

steps and writ 

OK as its 

caption!

Go to the On Click event of 

the button!

Ask the program to Requery the 

sub-form’s frame name by each 

click

 The filter is now up and running!
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 Hands on software (MS Access):

 Sub-form filtering
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 Create a filter form which shows different new project’s information with a project 

prelim cost between a range!

(Due: one day)
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 Reports are other object types in MS Access (in parallel to table, query and form). 

 It can be said that reports are special type of forms with specialized set of controls adapted 

for printing and presenting data (no data input is possible in the reports).

 Both data source and sub-form concepts are valid in report development steps!

 For creating new report you need to follow: Create> Report> Report Design

 Since development of the reports is  similar to form development (compared to form 

development report development is a simplified process because no input is received form 

the user), we skip discussing form capabilities).



Thank you!


